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Welcome to Click’N Design 3d
Click’N Design 3d gives you the tools to create professional-looking, high quality CD/DVD 
and jewel case labels for personal or professional use. Click’N Design 3d also provides 
background, clipart and texture images you can use to create your labels in addition to 
your own images and graphics.

Highlights of Click’N Design 3d

• Easy to use interface.

• Quick Design wizard that lets you create high quality labels in minutes.

• WYSIWYG editing. See what the end result will be on the screen.

• Create labels for CD, DVD, Jewel Case, Mini CD, Zip,
3.5” Floppy and Video tapes.

• Easily create circular text around the edge of your CD label.

• Browser for viewing the thousands of free clipart and photo images.

• Add barcodes to your labels.

• Add 3D text to your labels.

• Includes special effect filters you can apply to your photos.

• Support for drag-n-drop.

Minimum Windows System Requirements
• Power PC or greater Macintosh

• OS 8.6, OS 9 or OS X

• 32MB RAM (64MB recommended).

• 30MB free hard disk space (Up to 320MB if clipart content is included).

• 16 bit color, 800 x 600 or better.

• Mouse or other pointing device.
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Installing Click’N Design 3d
1. Make sure no other applications are running.

2. Insert the Click’N Design 3d CD-ROM in your computer’s CD-ROM drive
If the Click’N Design 3d Mac CD-ROM window does not open automatically, double-click the
CD-ROM icon to open the window.

3. Double-click on the Click’N Design 3d Mac Installer file icon.

4. Follow the on-screen instructions.

Starting Click’N Design 3d
Locate the Click’N Design 3d program folder and double click on the Click’N Design 3d
program icon to launch.

Creating a CD Label
This Quick Start Tutorial will take you step-by-step through the process of creating and printing
a CD and Jewel Case label for your CD project. Please start Click’N Design 3d and begin here:

STEP 1:
Click’N Design 3d supports CD, Jewel Case, Mini CD, Business Card CD, 3.5" Floppy Disk, Zip
Disk, Video Tape and full sheet labels from many popular label makers.

TIP: To change to a different label type, click on the "Type:" dropdown list box at the 
top of the dialog:

Select the template of the label you will
be printing to.

Click OK to continue

Click here to view the different types
of labels available.



5

STEP 2:
The Quick Designer quickly allows you to create a template that contains much of the informa-
tion you need including titles, content text and descriptions. As you change elements of a layout
you can view your changes in the preview area to the left. When you’re satisfied with the look
of your label, click OK to open up your layout on the label template.

Use the        button to browse through all the different selections.

TIP: To return to this dialog from within the Click’N Design 3d program, use the Quick Design
button located on the color palette control area:

STEP 3:
Editing your label:

TIP: Want to see the entire label, beyond the

curve? Click on the       button located on the

toolbar at the top of the screen.

STEP 4:
The 3D Text tool allows you to create dynamic titles for your labels:

For more information on creating 3D Text,
visit page 15.

1. Browse the different templates
using the Layout Controls.

2. Change any template by selecting
your own Backgrounds, Color
Schemes and Fonts.

3. When you’re happy with the
results, click the OK button.

The red border means that this
label is “active”. Click on any
other label to make it active.

With your mouse, double click
on the 3D text “CD Title” to
launch the editor.

1. In the text box, change the text
from “CD Title” to “Photos”.

2. When finished, click the 
Save Changes button to return 
to your template.
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STEP 5:
Selecting and moving an object around:

STEP 6:
Adding/modifying text on your label:

Overview of Text Toolbar:

(From left to right):

1. The "T" button allows you to select the font you want to apply to the highlighted text.

2. The "12 pts" and up/down arrow allow you to change the font size of the highlighted text.

3. The "S" button allows you to specify the font style to either Normal, Bold, Italic, Underline,
Condense or Extend.

4. The justification button allows you change to left, right, center or full justified text.

5. The Orientation button rotates the text 90 degrees left or right or you can specify a specific 
rotation degree (useful for creating text on a jewel case spine).

6. The Margin button allows you to adjust the margins.

7. The Text button switches between object mode (where you can move the entire text box) and
text mode (where you can edit the text inside the text box).

TIP: One text box can contain text with multiple fonts, colors and sizes. Highlight the text inside
the text box you want to change and use the Text Toolbar to modify it.
To add photos and other objects to your label, please see page 9.

1. Clicking on an object once selects
it. You will see eight control handles
surround the selected object.

2. By clicking on a red control handle
and dragging it left or right (while
holding down the mouse button), you
can resize your object.

3. By clicking and dragging anywhere
inside the control handles, you can
move the object.

Double clicking on a text box results in 
two actions:

1. Allows you to modify text.

2. Displays the Text Toolbar allowing
you to fine tune how your text is 
displayed.
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STEP 7:
Printing your label:

IMPORTANT NOTE ABOUT PRINTING:
When printing labels, alignment is very important. It is strongly suggested that you use the
Calibrate Printer selection under the File pulldown menu before printing. This will help Click’N
Design 3d center your prints to the label sheets you are using and can be used any time your prints
seem off center.

Congratulations! You’re now ready to apply your label to your media.

Creating a Jewel Case Label
STEP 1:

To open a Jewel Case Label template from within Click’N Design, use the main toolbar,
click on the "New" button        and you’ll see the following dialog box:

Now that your label is
ready to print, click on the
File pulldown menu and
click Print

1. Scroll down until you see the
Jewel Case section, select 
your label.

2. Hit the OK button.



STEP 2:
Use the QuickStart Wizard the same way you did when creating your CD label and 
when you are ready, click on the OK button to transfer the layout to the label.

TIP: Once the new template opens up, you may notice that your CD label has disappeared.
It has not, it is in the background. To bring it to the front:

STEP 3:
The back of the Jewel Case has 2 spines on the left and right of the label that is used for 
identifying a CD when it is on a shelf. To add and rotate text for this area,
please follow these steps:

After creating a new Jewel Case template, click on the text tool button         located 
at the top of the screen on the toolbar.

Click inside the label area and drag until you have a box outlined:

Once your text is typed in, use the

Orientation button          from the 

text toolbar and select "Up".

8

Click on the Window pulldown
menu and select your CD label
(it is the one that is not checked

When you have defined your text box,
begin typing in your text
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Your text will change from horizontal to vertical. Using your mouse drag and resize 
the text box until it is in the spine area:

STEP 4:
Finally, let’s add an image to the front of our label.

From the toolbar, click on the Import Clipart/Image button        . The image browser will open
and you will see all the available clipart that is part of Click’N Design 3d:

Once in position, use cut & paste

tools on the toolbar        

to create text for the other side.

Double click on this image to
add it to your label.
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The image will be placed inside the label:

TIP: If you want to bring text forward so that it appears over the image, use the Order tools
located on the toolbar                                .

Congratulations! You’re now ready to print your Jewel Case label using the same method you
used when you printed your CD label.

Did You Know…??
Tips and tricks to unlock the full power of Click’N Design 3d.

How the Image Tools work:
Besides including over 5,000 clipart images, Click’N Design 3d has powerful imaging tools that
allow you to use your own photos and graphics on your labels.

Tip 1: Did you know that Click’N Design 3d supports Drag-n-Drop?
Do you have a directory full of artwork or have a bitmap of your company logo? With Click’N
Design 3d open, you can drag your graphics file from Mac file folders directly into Click’N
Design 3d. To Drag-n-Drop you click on a file with your mouse and while holding down the left
mouse button (the same button you used to click on the file) move the cursor over the Click’N
Design 3D open template and release the mouse button. The file should now appear in your
template!

Note: By using the Clipart/Background icon located on the Tools toolbar, you can determine
if the dragged image will become clipart (which is moveable) or a background image 
(which is fixed).

= Image will be treated as clipart (movable and sizable)

= Image will be treated as a background image (fixed, always in background)

Use the red control handles 
to resize and position the image.

TIP: Right click on the image 
and select Effects.
You can add many special effects,
enhancing your image
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Tip 2: Did you know that you can fix the background image?
The main difference between using an image as clipart and using an image as a background
image is that the background image is fixed. It can not be moved, sized or have special effects
applied to it. There are 2 types of backgrounds; Images and Gradients. You can insert by using
the following toolbar buttons:

Tip 3: Did you know that you can add special effects to images?
Once you have an image inserted into your template, click once on it to highlight it and under
the Tools pulldown menu, select Effects...

The following dialog will be displayed:

When you are pleased with the effect, select the OK button to continue.

Slect the desired effect.

(You can see a preview in the box below)

Images: Use photo or clipart images
as your background.

Gradient: Click on the button to see gradient
options. Gradient selections use the 2 colors
that are currently selected in the color palette.

To see a complete list of effects, click on 
the Select Effect... button.

As you select an effect, the filter controls
appear in the right area.
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Tip 4: Did you know you can make an image “see-thru”?
Adjusting the transparency of an image is an old trick designers use in order to make their text
stand out better. To make an image transparent, use the instructions in Tip 3 to bring up Effects
dialog. Select the Cross Fade effect and use the slider bar to the right to adjust the amount of
transparency you want to apply to the image:

Example:

Before (No opacity) After (50% opacity)

Tip 5: Did you know that you can change the aspect ratio of any image?
If it doesn’t fit correctly, force it! To adjust an image to make it fit in a space, use the
control bars that are part of any selected image. First, start off by selecting an image:

To maintain the images aspect ratio (in other words, make it so that you can only resize, not
stretch or squish the image), use the Resize Aspect Ratio icon on the Tools toolbar:

Grab a control and move it left, right or up, down and adjust the image 
until it fits in the space you want.

The SOLID RED control
handles allow you to resize,
stretch and squish the
image.

The SOLID RED and 
OPEN RED control handles
allow you to resize the
image without distortion.

Click this icon to fix or release the
aspect ratio of the selected image.
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Tip 6: Did you know you can add a Barcode to your label?
Adding a barcode to the back of your Jewel Case can be easily accomplished by 
using the Barcode icon located on the Tools toolbar:

When you select the Barcode tool, you’ll see the following dialog:

How the Text Tools work:
Round labels require round text but there is more to Click’N Design 3d than you know:

Tip 1: Did you know that one text box can have different fonts, sizes, colors, etc…?
Want to bold one word in a paragraph or change the color to red so that it stands out? These
controls and more are available to you. First create a text box and type in some text. Then,
using your mouse, click and drag, highlighting only the text you want to change (if you’re using
an existing text box, you may have to double click inside the box in order to be able to highlight
a specific line of text).

Now, notice the Text toolbar:

From here click on the Bold icon         and then click on the Size Control .

Enter barcode text here.

Clicking OK will insert the
barcode onto your label.
It will be movable but not
resizable.

The barcode is created as you type text here.
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Notice how only the text you highlighted in your text box changes?:

Before After

Tip 2: Did you know you can create round text?
It’s so easy! Click on the Circular Text tool located on the Tools toolbar.

You will see the following dialog appear:

Now, start typing in the text you want. From this dialog you can change the angle of the text:

0 = top of label 180 = bottom of label
90 = right side of label 270 = left side of label

You can also change the text font, size, color and more… 
When you’re finished, click anywhere inside your label to 
close the Circular Text dialog (to return to the dialog 
simply click on the circular text itself).

Once entered, you can adjust where your circular text is
located on your label by clicking on the outline and 
dragging it in or out:

Other effects you can apply to your text are:
- Italics & Underline text
- Justify text left, center or right
- Rotate your text up, down or at a specified degree
- Adjust margins in a text box
- Toggle between editing the text and moving the text box
- Fill the text box background with a color
- Insert characters (ie. © or ®, etc…)
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Tip 3: Did you know you can create 3D text?

The ability to add 3D text to your label is one of the most powerful features of Click’N Design 3d.
To add 3D text to your label, start by clicking on the 3D Text icon located on the Tools toolbar.

You should now be looking at the 3D Text dialog:

Using the 3D View Controls:
Tools (from left to right):

• Zoom: Makes the text larger or smaller depending upon how much text there is to view. Zoom 
adjusts the field of view. To zoom in on the text without affecting the field of view, use the Dolly control.

• Dolly: Moves the text in closer or farther depending upon the movement of the mouse cursor.

• Scale: Makes the text larger or smaller. Can also use to stretch and squish text.

• Move: Moves the text around the screen.

• Rotate: Rotates the text around its axis adjusting the 3D view.

To use each of these controls, click inside the 3D text area with your mouse cursor and while
holding down the mouse button move the mouse up or down, left or right. In some instances,
releasing the mouse button and repeating the action is necessary to achieve the desired effect.

Effects Tab:

Start by typing your text here.

Change the text attributes here.

When you are happy with how it looks,
click the Transfer 3D Text button to 
apply it to your label.

Effects: Applies pre-defined
text formations such as
Perspective, Arcs, Waves,
Curves and Slants.

Extrusion: Adjusts the 
thickness of the text..

Bevel: Adjust the depth of the
bevel around the face (front) 
of the text.
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Material Tab:

Texture Tab:

Light Tab:

Background Tab:

Materials: Applies pre-defined material types
such as Plastic, Rubber, Brass, Silver,
Chrome and more…

Adjust the lighting of your text

• Ambient: Background lighting (best when dark).

• Diffuse: Most important setting. Sets color tone.

• Specular: Sets highlight color.

• Emission: Adds color to other colors chosen.

• Shininess: Makes text shiny or dull looking.

2. Once you’ve selected your lighting,
use the Zoom and Move button to
adjust your display in order to see and
move your lights

Texture: You can map an
image to your text or you can
add a gradient color.

Mapping: When you add a
Texture, you can control how
it looks applied to your text
by manipulating mapping
type and coordinates.

1. Select how many lights you want
(the longer the text, the more lights 
you want).

Point light is a focused light like a 
spot light.

Directional light is a broad light
much like light from a light bulb.

Add an image or gradient background
to your 3D text.
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How the Display Tools work:
Want to see the whole label (not just the round part) or need a grid and centering tools? Want to
lock an object? Here’s some tips for navigating through the Click’N Design 3d display:

Tip 1: Did you know you can have multiple labels open at the same time?
The ability to have multiple labels open at the same time allows you to work on CD, Jewel Case
and other labels at the same time. This makes it incredibly convenient when copying or pasting
artwork and other similar elements. To navigate through all open documents, use the tools
located under the Window pulldown menu.

Tip 2: Did you know you can see beyond the boundaries of a CD label?
In order to give you a true representation of what your CD label will look like when printed, the 
template crops the unused areas of your graphics. If you would like to see these areas, click on the
Crop tool located on the Position toolbar. Click the icon again to return back to the cropped view.

Clicking on any of the selections allows
you to see all the open labels.

To bring a specific label to the front,
click on the desired label name listed at
the bottom of the pulldown menu (this
list represents all the open labels).

Click once to see graphics beyond
the label, click again to clip.

Label with clipping ON Label with clipping OFF



Tip 3: Did you know you can center any object?
Lining up multiple objects can be very helpful in creating a good-looking design. The tools avail-
able to help with this task are located on the Position toolbar. To center an object, first, click on
the object you wish to center and then click on the Centering icon. The object will be moved to
the center of the template you are working on.

Tip 4: Did you know you can lock an object in place?
Locking an object means that it can not be moved or editing. This is helpful when there are many
objects on the template. To lock an object, select that object and then click on the Lock icon 
located on the Position toolbar. You can unlock the object by again clicking on the Lock icon.

Tip 5: Did you know you can move an object behind other objects?
Did your text disappear behind the image you just inserted? To view that text, click on the image
so that it is highlighted and click on the Send to Back button on the toolbar.

Your text should now be on top of the image. Other tools like this one are:

- Bring to Front: Brings object to the very front of the template 

- Up One Level: Brings the object up one level (example: If there are 4 objects and this is the 
bottom object, it will be positioned between object #2 and object #3).

- Down One Level: Sends the object down one level.

- Send to Back: Sends the object to the very back of the template so that it is behind 
all other objects.
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Off-centered object Using Center on Label icon:

Centering tools (left to right)
- Center Horizontal
- Center Vertical
- Center both Horizontal and Vertical
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Tip 6: Did you know you can create and snap to a grid?
Using the Grid button on the toolbar, you will see the grid appear in your template. To snap to
the grid, click on the Snap icon on the same toolbar.

To adjust and snap to the grid, click on the Files pulldown menu, select Perferences and 
then on the Appearance tab.

Tip 7: Did you know you can see the entire label sheet and not just a portion of it? 
To see the entire template sheet (most are as big as an 8.5x11 sheet of paper), click on the
zoom tool in the Display toolbar. Click on the 25% selection. You should now see the entire 
template which should look exactly like the paper you will be printing it to.

Zooming out to 60% or lower will give you
an overall view of your template.
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Technical Support  
Technical Support and Product Updates

Stomp is serious about customer satisfaction. If you’re having difficulty with Click’N Design 3d,
please follow these steps:

1. Check the Stomp website. Common problems and their solutions can be found there.

2. For telephone technical support, please call 949-515-5299. Before calling, please have 
the following:

• Your Macintosh configuration (CPU, recorder make & model, OS version ).

• Description of the problem you are encountering.

Note: When calling for support please be at the Macintosh where the software is installed so the technical
support technician can assist you in resolving the problem.


